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Introduction & Coverage

Enterprise Architecture Management is vital to achieving agility, reducing risk, increasing effectiveness
and efficiency in today's pressured organisations. Historically, support has been sought in ad-hoc tools
(Word, Excel, Access, Visio) or CASE-derived modeling tools originally intended for software, process or
data modeling. These lack some essential elements to effectively manage frameworks, document
current architectures, develop future scenarios and manage initiatives towards achieving goals:
especially when it comes to gaining buy in from non-technical executives and collaborating with
sponsors, decision makers and "owners" of various architecture dimensions.

This talk discusses the requirements for a successful EA tool; how these differ from previous
approaches; the design of one such "new generation" web/repository based tool capable of supporting a
variety of frameworks and user categories. The talk will conclude with a brief demonstration of some
unique capabilities followed by questions and discussion (time permitting).

= EA Goals

= EA Support Tool Requirements

= EA Tool Design

= Features to Meet Criteria

= Archi/WebModeler Architecture

= Demonstration

= Contacts Inspirec
= References 7. Consulting - Traning « Research
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= EA Goals according to

Schekkerman
» Managing Complexity
» Support Decision Making
» Roadmaps for Change
» Support Budgeting and Prioritisation

» Insight and Overview of Business
and IT

» Support Systems Development
» Manage IT Portfolio
» Helpful for Mergers and Acquisitions

= CEO Requirements

according to Spewak and Hill

» Business to IT Alignment
— Structural
— Strategic
- Inter-Domain

Copyright Inspired
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EA Requirements

= Zachman (Enterprise Architecture, the issue of the century) www.zifa.com
» Only first three levels of framework!
» Spewak agrees.... (top two layers..)

» Also see Zachman and Sowa "Extending and formalising the framework for information systems
architecture" article for need for integration across the cells
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= Systems Thinking (Checkland, Copeland, Avison.. )
» Multiple Perspectives
> [terative / Sense Making / Alteration
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EA Requirements(from Literature and
| Experience)
= Comprehensive

» Coverage of Domains (Business, Process, Application, Information, Technical...)
= Currency/Accuracy
= Add Value
= Comprehensible to all participants
= Sharable
= Distributed
= |nvolvement of Stakeholders
= Service Oriented Architecture
= Governance (SOxley; COBIT; ITIL ...)
= Manage the EA process
= Secure
= Support Initiative/Transition Management
= Link to other concerns e.g. Risk, Quality Mgmt
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User Communities/Roles Supported

= Enterprise Architects
» Business Architects
» Process Architects
> Applications Architects
» Information Architects
» Technical / Infrastructure Architects
» Integration Architects
= Strategic Planners
» Business
>IT

= Programme Managers
> EA
» Initiatives
» Project Office

= Risk Managers
= Methods Engineers
= Software Architects

= Vendors

= Sponsors

= Project Staff Inspired

= Quality Assurance /
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Repository, Knowledge Artefact

| | Reqguirements
= Object/Semantic Model
= Rich Data Types
» Dates, Pictures, Documents, Templates,
Hypertext, Hyperlinks

= Persistence on Relational
(SQL/ODBC)

= Transactional
» Robust, traceable

= "Soft" Meta Model

» Runtime extension

= Managed Artefacts

> Various types (Documents, Presentations,
Diagrams, Spreadsheets, Project Plans..)

» Date/Time Stamping
» HTTP upload/download
» Versioning

= Exposed Directories

» Previously or externally gathered

information
Copyright Inspired 2005
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EA Tool Requirements (Shekkerman)

= Functionality = Checklist
» Methodologies and Models » Operational and Technical Fit
= Frameworks (agnostic) — Platform
» Model Development Interface — Performance and Availability

— Security/User Admin

— Software Distribution

— Release Management

— Tool Architecture

— Technical and operational Requirements

» Tool Automation
—Import/Scanning

» Extendibility and Customisation
- Meta Modeling

- Security
—User Interfaces/Programmability ’Vend(_)r Support 3
» Analysis and Manipulation > Functional Fit (Specific)

= Support Analysis
= Support of EA Frameworks
= Support of EA Program (time)

» Repository
= Collaboration

~Openness _ — Simulation
» Deployment Architecture — Repository Management
» Cost and Vendor Support — Validation of Models
.r- . = Support of Standard Languages and Techniques
= Utlllty to PrOfeSS|Ona|S = Support for EA Review Management
» Ent Architect » Functional Fit (General)
» Strategic Planners — User Interface

— Customization

» Enterprise Programme Managers .
P 9 9 - Import/Integration

» We can add: Project Managers;

> — Reporting
Implementors; Vendors; Domain ~ Version Management
specific architects; Process — Document Management
Architects; Risk Analysts etc. — Help and Tutorials
— Libraries (Graphics) )
— Code Generation?? Ins p kel

» Commercial and Credibility

He comments that only the relevant level of detail should be attempted in models, otherwise the task becomes unachievable

I.T. Consulting « Training « Research
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EA Tool Requirements (Spewak)

= Query = Flexibility of output

= Analysis (integrity, level, affinity, » Matrices
ranking) » Indented lists

= Methodology » Hierarchy diagrams
compatibility/adaptation » Simple lists, cross reference lists

= Kinds of Objects (files, fields, > Full C?escription (formatted text)
relationships) > ER diagrams

» Gant charts and schedules
» Dataflow diagrams

» Presentation Graphics

> Text (free form)

= Extensibility

= Ease of learning, using and
changing data

= Data entry forms

= Multiple or single access

= Performance/efficiency vs size of
database (responsivenes)

= Toolset compatibility and integration
- Import/export

Inspired
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EA Tool Requirements (TOGAF)

= Functionality

» Framework Support - Customizable or own
» Deliverable Support

» Glossary/Taxonomy

» Non technical views

» Meta Modeling

» Multi User Collaboration

» Drill Down / conceptual/Logical /Physical etc.
» Traceability

= Architecture

» Repository central or distributed

» Dynamic repository

» Standard database or proprietary

» Backwards compatibility

» Integration and consolidation into one repository
» Version control

» Web Client

» Platforms?

> Security = Life Cycle Support

:geport GeLn eration d Notati » Full lifecycle support?
ommon Language and Notation » Basic required views "out of the box"

= Intuitiveness/Ease of Use > Custom Views
» Process Map » Modeling support
» Online Help » Simulation
» Prebuilt models » Executable output?

» Visual modeling/Drag and drop - Interoperability Factors
= Customization » Import/Export (including from other tools)

] Change tracklng and audltlng > Integration with other tools

) . » Industry standard APIs
: O.rga.nlzmg Artefgcts/Namlng standards » Support for industry standards (HTML, XML, UML)
= Viewing and relating artefacts

= AP| available? = Financial Considerations

e > Initial cost
= Organizational Factors »TCO

» International/Multi Language
> Distributed operation = Vendor Factors

= Tool Capacity/Scaling
» Size of Data/No of Files/Number of records/objects
» Upgrade path

Inspiree
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EA Tool Requirements (From RFPs)

= Meta Modeling capability
» Types , relationships
» Aspects
» Extensibility

= Modeling capability

» Coverage: Business, Applications, Process,
Information, Technology, Risk, Cost...

= Shared, Collaborative
= Ease of installation, deployment

= Structured, Semi-structured, ad-hoc
knowledge

= Search Capabilities

= Open, interoperable

= Multiple Perspectives/Frameworks

= Visual Modeling

= Repository Management, evolution

= Reporting

= Analysis

= Inferencing (incl generation of visualization
from inferred rels)

= Affordable

= Time dimension

= Filters

Copyright Inspired 2005

» Multiple Scenarios

» Non-redundant

» Auditability

» Version Management
> Asset testing

» Security

» Rich content
—various data types

» Directory exposure/monitoring

» Meta data management, domains, audit trail
» Content analysis and status reporting

» User customization

» Methods engineering/Program Management
support

» Performance/response time
» Standards encouragement
» Easy data capture/import

» Available models (Zachman, TOGAF,
Inspired, DODAF, COBIT etc. )

» Reliability
» Support levels of abstraction

11



= Support
» Architecture Management
» Methods Engineering and Use
» Strategy and Programme Management
» Professional, knowledge intensive work
» Distributed Teams
» Multiple Frameworks

= Central shared, transactional repository
» Hold structured, semi structured and unstructured data
» Support all "document types" client can handle
» Object Oriented model, relational storage
» Support links to external content
» Version management and audit trail
» Method templates

= Server based product - thin client
» Web Interface, X Browser
> "Zero Deployment”

Design

= Tool integration, API to support other tools

» Batch, XML, CSV
» Realtime, WEB Svc, XML, CSV, API

= Easy Loading

»Web forms, relating tools
> Import

> Visual Modeling

> External DB Access

> Spreadsheet Integration

» Directory access / monitoring

= Runtime extensible

» Meta Model Edit via Browser, internal documentation
» Calculations
> Events

» Custom Views

= Flexible Capture, Viewing, Navigation, Analysis and

» Central Installation and Administration (tho latter can be done thru

browser interface from anywhere)
» Provide all necessary management utilities (users, security,

performance, import, export, migration, error handling, support

etc.)
» Stateful, sessions, security, currency

= Pattern Based

= Standards Compliant
»HTML, HTTP
> XML, XMl
> CSV
» Relational Database
» Standard web server

= Events
> Support automation, monitoring, collaboration

Copyright Inspired

Output of Data

= Easy Output

> Report Generation

» Composite Documents

» Portal Support

» Publishing - web site gen
» Visual Models

» Status via picture

= Collaboration Support, Discussions
= Customisation

» Menus )
» Custom Views Ins p 10
> Settings

I.T. Consulting « Training « Research
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E ;/.i;eiallisl\i/loodeling Tools
= Archi Architecture
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= Collectors

= Import M=
> XML :
»CSV o

= Capture
»Web

» Visual Tools

= Read from sources..

> SQL

= eMall
» With Attachments

= Directory Monitoring
= Directory Exposure

Copyright Inspired
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= Models —
= Domains =
> Nested —

» Non-exclusive

= Frameworks
» Visual
» On top of types

= Same Type Relationships
» Hierarchies
» Networks

= User Defined Relationships

= Subject Ontology

= Searchable

= [nternal/Local/External Choice

.

Content Organization

frameworks

e etk | (g Vi | b et
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= Spatial

= Graphical

= Documentor

= Context

= Report

= Composite Doc

= Portal

= \Website

= VVisual Model

= Presentation Model

= Export
» XML
»CSV

Copyright Inspired

Output Views
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Scenarios and Evolution

= Architecture Elements
» May satisfy requirement in a variety of scenarios

» OR may be used in one, but discontinued or under evaluation in another
» Need a view on the element per scenario...

= Architecture Scenarios

» Supported via relationships and filtering

» Allows considering any combination of scenarios
—No redundancy of shared elements
—Unique perspective on element within a scenario

= Visual Modeling

> Allows extracting a model, modifying, generating a new model
» While sharing all common elements
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Inferencing, Computation

= |Inferencing of Relationships

supports supports BUSlneSS
- System
Process

supports

= Computation
» Declarative
» No Repository Access Code required
» Can be recursive
» Immediately interpreted
» Full, rich object language
» Powerful API

» Support for recursion
—with control of cyclical problems

Copyright Inspired 2005
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Visual Models, Transformation

Model

Type
<XML>

T

.

e 00100
sl 8 Model 00 0 0|0
e e Type 0/0 O 0|0
| Ao <XML> 0/0 0 0|0
= i 0l0 0 0|0

C

= [tems can participate in multiple models
= with different representations

= Model Types provide a mapping between visual
representation and internal meaning

= Model exchange occurs over HTTP links I
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= XML

» [nstance Data

» Attached Assets and Graphics

» Meta Data
» Custom Schemas

=CSV

» Template generation
> Import
» Generation
= Requestor
» Middleware
> API
> Scripting
> Visio, Powerpoint, Word....

= Custom Menus
= Custom Views

Copyright Inspired
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Auditing, Evaluation of Progress,

| Managemen
= Delta Views
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Meta Modeling

= Easy web interface
= Define/Modify

= Types

= Relationships

= Properties

= Preferred spatial layout
= Internal Documentation
= Immediately Usable

= Patterns Customise User
Interfaces and Business
Logic
= Impact Analysis
Supported

= Model Comparison
Supported

= Change Auditing
= Visio Integration

Inspired
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= Meta Modeling

» Type Browser, Instant updates to Ul
= |nput, linking
= Atefact management

» Content view

= Matrices and Inferencing
» X Ref

= Spatial View Access
» Frameworks, Drill Down, Query

= Inferencing in hierarchies in Context
= Computation
»e.g. Gap
= Filtering/Scenarios/Gap Analysis
» By Scenario, Business Unit, Domain, State
= Calendar, Programme View
= Reporting, Composite View

= Visual Models
» Meta
> Instance: Process; Application Architecture

= Output: Portal, WebSite, Documentor

Copyright Inspired 2005
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= Presenter

» Graham McLeod
—email: mcleod@iafrica.com
—phone: +27 21 531 5404
—mobile: +27 82 578 1834

= |nspired
> www.inspired.org
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